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Overview

SnagIt is the screen capture and print
program for Microsoft Windows 3.0. With
SnagIt, Windows users can capture an
entire screen, a portion of the screen
or a single window or icon. SnagIt
sends the captured area to a printer,
the Windows clipboard or a file. These
images can be pasted into other Windows
applications such as word processors and
desktop publishing programs.

A Solution UsedSnagIt provides a simple solution to the
Daily problem of importing high quality

Windows screens into documentation.
SnagIt is a practical, easy-to-use
addition to the programs and tools
utilized daily by Windows users.

Documentation SnagIt allows documentation writers to
Writers cut and paste Windows screens into user

manuals, marketing literature,
advertisements, newsletters, and other
documents.

Windows With SnagIt, Windows programmers can
Programmers quickly create printouts of program

screens, windows, and icons for
presentation and review.

Application SnagIt provides screen print
Developers capabilities for other Windows programs.

Programmers developing applications with
Microsoft Excel macros, Gupta's
SQLWindows, Asymetrix's ToolBook, and
other tools, can activate SnagIt with
dynamic data exchange (DDE) messages.

DOS Users SnagIt provides DOS users with print
screen capability for applications
running in a DOS session under Microsoft
Windows.
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About this Manual

This manual shows you how to install and
use SnagIt and is divided into three
sections.

In the first section, Installation:
Computer system requirements are
listed.

Setup instructions describe how to
install and configure SnagIt.

Getting Started teaches you the basic
operation of SnagIt.

The second section, Reference:

Describes program operation, menu
selections, and options available in
SnagIt.
Keyboard operation and mouse
controls.

Input, output, format, and option
menus.

Shows how to save the SnagIt's
configuration.

The third section, Dynamic Data Exchange
(DDE):

Explains how to use DDE messages.
Contains the DDE reference that lists
the DDE commands supported by SnagIt.

Appendix A of this manual lists other
products available from TechSmith
Corporation.
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About this Manual

This manual was created using SnagIt and
Microsoft Word for Windows.
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Installation

System To use SnagIt, you need:
Requirements

An IBM PC or 100% Compatible
Microsoft Windows 3.0
A mouse or other pointer device

Any printer that supports bitmaps
such as an HP LaserJet or a
Postscript printer

Setup To install SnagIt:

1. Insert the SnagIt diskette in drive
A: or B:.

2. Start Microsoft Windows.

3. From the Windows Program Manager,
choose Run from the File menu

4. On the command line type a:setup or
b:setup, as appropriate
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Installation

5. Press Enter.

The following dialog box is displayed.

The SnagIt installation dialog box

User 6. Enter your name and your company
Information name in the User Information group

box.
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Installation

SnagIt Installation dialog box
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Installation

Load 7. If you want SnagIt to load
Information automatically when you start

Windows, click on the check box in
the Load information group box.

8. If you want to install SnagIt to
the Window's default directory and
the Accessories group, choose Ok.

If you wish to install SnagIt to a
different directory or group than
shown, enter the name of the new
directory or group name and choose
Ok.

Note: If you leave the group option
blank, SnagIt is not installed in any
group. In this instance, you can run
SnagIt using the File Run command from
the Windows Program Manager.
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Getting Started

In this section you will learn how to
use several of the basic features of
SnagIt and create your first screen
print.

Loading SnagIt 1. Start Microsoft Windows.

2. a) If you configured SnagIt to load
automatically during the setup step,
you will see the SnagIt icon
displayed at the bottom of your
screen.
b) If you did not configure
SnagIt to load automatically, load
SnagIt by selecting the SnagIt icon
from the group selected during Setup.

c) Execute File Run from the Program
Manager and enter the path to SnagIt
and press enter.

Using SnagIt You can use SnagIt to print the entire
screen, a selected region of the screen
or a single window. Our Getting Started
example will show you how to select the
input and output choices to send a full
screen to the printer.

First, restore SnagIt by selecting the
SnagIt icon.

SnagIt Main menu
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Getting Started

The SnagIt window shows the menu and the
current settings for the program
choices.

Selecting the For our example select the Input menu
Input Region item to view the list of SnagIt input

choices and select Screen as the input
region choice.

SnagIt Input menu

Selecting the Select the Output menu item to view the
Output Choice list of SnagIt output choices and select

Printer as the output destination
choice.

SnagIt Output menu

Capturing the To start the capture process, send the
Screen screen to the printer, press

[Ctrl][Shift]P simultaneously.
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Getting Started

While SnagIt is busy printing the
following message box is displayed.

To cancel the printing operation, select
the Cancel button in the message box. A
message box will be displayed with the
message "Output canceled by user." If
the printout is canceled a portion of
the image may have already been sent to
the printer and will print.

Printing a To illustrate a second SnagIt feature,
Region select Region from the Input menu

choices.

Press [Ctrl][Shift]P simultaneously.

The cursor will change from an arrow to
cross hairs. Use the cross hairs to
select a region by holding down the left
mouse button and dragging the cross
hairs to the lower right corner of the
region you wish to capture. Release the
mouse button.

The region you selected will now be
output to the printer.

Complete descriptions of the menu
options are available in the Reference
section of this manual.
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Reference

This section of this manual describes
the mouse buttons, keyboard commands,
and the features and options of the
SnagIt program.

Mouse Buttons A mouse is required when using SnagIt.

Left Button - The left mouse button is
used to select SnagIt menu options and
to select screen regions and windows.

Right Button - The right mouse button is
used to cancel a region or window
selection.

Keyboard The following keyboard commands are used
Commands in the operation of SnagIt.

Ctrl][Shift]P - Activates SnagIt
printing.

[Ctrl][Shift]X - Makes the SnagIt icon
or window disappear from the screen.
Pressing [Ctrl][Shift]X a second time
causes the icon or window to reappear.

SnagIt Menu This section describes the operation of
each command on the SnagIt menu bar.
The SnagIt menu bar has five choices:
Input, Output, Format, Options and Help.

The Input option allows you to select
the particular screen image, icon,
window or bitmap file or clipboard
content that you want SnagIt to capture.

The Output option allows you to select
an output destination for images
captured by SnagIt. Output options
include the printer, a bitmap file, 7
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Reference

monochrome TIFF file, or the Windows
clipboard.

The Format option allows you to change
how the SnagIt image will appear in
finished form: monochrome, color, or
gray scale.

The Options choice allows you to select
from a number of additional features
offered by the SnagIt program including
alert beeps, color boost, scaling, and
clipboard chaining.

The Help option provides information
about each menu selection.
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Input

The Input menu is used to select the
screen, window, or bitmap file or
Windows clipboard content that you want
SnagIt to capture.

SnagIt Input menu

Input options 1. Select Input on the SnagIt menu.

2. Select from the following options.

Screen Select Screen to capture the entire
screen.

Window Client Select Window Client Area to capture
Area only the client area of a single window.

The client area is the content area
inside the window borders. The client
area does not include the borders, title
bar, menu bar, scroll bars or the
caption line.

After you press [Ctrl][Shift]P, select
the client area you wish to capture by
positioning the pointer anywhere in the
client area.

Press and release the left mouse button.
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Input

Entire Window Select Entire Window to capture a
complete window including the borders,
title bar, menu bar, scroll bars and the
caption line.

After you press [Ctrl][Shift]P, select
the window you want to print.

Press and release the left mouse button.

Window To select the window you want, not
Selection Tip smaller windows such as buttons or

icons, select the title bar. Items
within a window, such as the Ok and
Cancel buttons, are actually small
windows. Therefore, if you select one
of these items, that item will print,
rather than the entire window.

Region Select Region to capture a rectangular
region of the screen.

After pressing [Ctrl][Shift]P, position
the pointer to the upper left corner of
the region to capture. Press and hold
the left mouse button while you drag the
pointer to the lower right corner of the
region. A rectangle starting at the
upper left corner will follow the
pointer, outlining the selected region.

Release the mouse button.
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Input

Bitmap File Select BMP file to capture an image
stored in a bitmap file.

When you press [Ctrl][Shift]P, SnagIt
displays a dialog box requesting the
file name.

Enter the file name.

Choose Ok or press Enter.

Bitmap files are graphics files
generated by some paint programs, SnagIt
or other Windows programs. Bitmap files
have a file extension of "BMP."

Clipboard Select Clipboard to capture the contents
of the Windows clipboard. Items are
placed on the clipboard by using SnagIt
or the cut and copy commands in other
Windows programs.
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Output

The Output menu is used to select the
destination for the images captured by
SnagIt. SnagIt supports the following
destinations:

SnagIt Output menu

Printer Choose Printer to send the captured
image to the currently selected Windows
printer.

Clipboard Choose Clipboard to send the captured
image to the Windows Clipboard.

Bitmap File Choose BMP File to send the captured
image to a bitmap file.

TIFF File Choose TIF Mono File to send the
captured image to a TIFF file in the
Intel format.

Note: To select TIF Mono File, you must
first select monochrome or gray scale
from the Format menu.
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Output

Naming After you capture an image, SnagIt
Destination displays the following dialog box asking
Files for a file name.

Enter a filename.

Choose Ok or press Enter.
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Format

SnagIt provides three different format
options: Mono-chrome, Color, and Gray
Scale. Select the format choice from
the Format menu.

SnagIt Format menu

The following format choices are
provided.

Monochrome The input image is converted to
monochrome before it is sent to the
output destination. The intensity
threshold level determines the amount of
black and white that will appear in the
output image.

When you select Monochrome, the
following dialog box for setting the
Intensity Threshold is displayed.

Intensity Threshold dialog box
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Format

When Microsoft Windows converts a color
image to monochrome, it converts the
background color to white. All other
colors are converted to black. As a
result, too much of the image is now
black. To prevent this, SnagIt uses an
intensity threshold to control the ratio
of black and white resulting from the
conversion process.

SnagIt looks at the intensity level of
each pixel and converts higher
intensities (lighter colors) to white
and lower intensities (darker colors) to
black. This conversion process usually
results in a more even balance of black
and white in the output image. The
amount of black and white is controlled
by adjusting the Intensity Threshold
value.

Color All color information for the selected
image is sent to the output device

Gray Scale Gray scaling is an alternative to
monochrome conversion.When Gray Scale is
selected, colors are represented by
shades of gray.

SnagIt can represent colors with 256
levels of gray. The shades of gray are
determined by the intensity level of the
colors.

Caution: Gray scaling is a pixel by
pixel process and can be very slow. You
may want to experiment with gray scaling
by printing a small region of the screen
before printing the whole screen. You
may also want to enable the Alert
feature under the Options menu to let
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Format

you know when the gray scaling process
is completed.
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Options

The Options menu provides additional
features for SnagIt users: Alert,
Clipboard Chain, Color Boost, and Scale.

SnagIt Options menu

Alert Set the Alert option to have SnagIt
signal you with a beep(s) when it has
completed processing. There is an alert
option for both input and output
processing. The values entered for
these fields determine the number of
beeps. This feature is particularly
useful when using the Gray Scale option.

Alert dialog box

Clipboard ChainSetting the Clipboard Chain option
causes SnagIt to print each time new
information is sent to the clipboard.
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Options

Clipboard chaining is useful for
printing a screen from a DOS session.
When you press the [Print Scrn] key in a

DOS box, Windows copies the screen to
the clipboard. If you have selected the
clipboard chain option, SnagIt
automatically copies the image to the
printer for you.

Note: To select Clipboard Chain, the
input device must be set to Clipboard,
and output device must be set to
Printer.

Color Boost Color Boost is used to adjust the color
intensities for red, green, and blue
portions of each pixel. This option may
be used for color separation,
brightening, or darkening the output
image. When Color Boost is selected, a
dialog box is displayed for color boost
values.

Color Boost dialog box
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Options

You may control the intensity for each
pixel in two ways.

1.Increase or decrease intensity
levels of each color by a
percentage (saturation) by using
the slider bar.

2.Add or subtract intensity levels
(hue) for each color range by
entering a value from -255 to 255.

The default value for each additive
range is zero and the percentage bar is
100%.

To activate color boost, click on the
"Use Color Boost?" check box.

Color boost is used to change the
intensity of the colors. Increasing the
boost value lightens the output. SnagIt
performs color boost before gray scaling
or monochrome conversion. Therefore you
can use color boost to lighten or darken
the output with those options as well.

Scale The Scale option allows you to enter an
integer scaling factor that is applied
to the input image. With a scaling
factor of 2 the output image will be
double the size of the input image in
dots. With a 300 dpi laser printer, a
scale of three (3) is a good place to
start.
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Options

Scale dialog box
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Save Setup

SnagIt can save all of the currently
selected options from each SnagIt menu.
The Save Setup option is located under
the System Menu.

SnagIt System menu

You can access the System Menu by
pressing [Alt][Space] or by selecting
the Close Box (minus sign) in the upper
left corner of the SnagIt window.

Save the current configuration by
choosing Save Setup from the System
Menu.

When you save the setup, SnagIt writes
all of the current settings to your
WIN.INI file. SnagIt then uses the
saved setup each time it is loaded until
you save different settings.
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Dynamic Data Exchange

SnagIt supports Windows Dynamic Data
Dynamic Data Exchange (DDE). You can invoke SnagIt
Exchange Use from other Windows programs by sending

SnagIt DDE Messages. For instance, you
can write an Excel macro that will print
a portion of the screen using SnagIt.
For more information concerning please
see the DDE section in the Software
Developer's Kit reference book "Windows
Guide to Programming."

Initiating a To initiate a DDE session with SnagIt,
DDE Session send a DDE_INITIATE message with the

application parameter of "SnagIt" and
the topic parameter of "System".

Setting SnagIt SnagIt's Set command configures SnagIt's
Options operation in the same fashion as though

choices were being selected from the
menus.

Usage:

[set ("string")]

Example: Set the Input menu choice to
Region.

[set ("input region")]

The parameter string must be one of the
following strings:

input screen (input = screen)
input client (input = client
window)
input window (input = entire
window)
input region (input = region)
input file (input = BMP file)
input clipboard (input = clipboard)
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Dynamic Data Exchange

scale n (option scale = integer >
0)
output printer (output = current
printer)
output file (output = BMP file)

output clipboard (output = clipboard)
chain b (option chain = True
or False)
boost red, green, blue (option boost =
Enabled)
boost off (option boost =
Disabled)
add red, green, blue (option boost =
Enabled)
add off (option boost ²
Disabled)
inalert n (option alert input =

value)
outalert n (option alert output
= value)
window hide (hide SnagIt)
window show (unhides SnagIt)
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Dynamic Data Exchange

Activating SnagIt's capture process is started by
SnagIt sending a DDE_EXECUTE command with Snag

message:

Usage:
[snag("string")]

Example: Snag the client window, handle
0x43B, to the selected destination

[Snag ("client handle 0x43B")]

The string parameter must be one of the
following:

empty or null (equivalent to
[Ctrl][Shift]P)
clipboard (get image from the
clipboard)
screen (get the image from
the screen)
filename (get image from BMP file)
x y (get entire window under
the point)
client x y (get client window
under the point)
handle h (get entire window from
handle)
client handle h (get client
window from handle)
tx ty bx by (get region between
two point

Note: All numbers may be decimal or
hexadecimal. Hex values must start with
"0x
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